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Introduction

About this Guide

The RocketRAID 152x eSATA Host Adapter’s User’s Guide provides information

about the functions and capabilities of the RocketRAID 1522A and RocketRAID 1520

host adapters, and instructions for installing, configuring and maintaining RAID

arrays hosted by these adapters.

Introducing the RocketRAID 152x Host Adapter

The HighPoint RocketRAID 152x series of host adapter cards are 2-channel PCI SATA

RAID controllers.  The RocketRAID 152x solutions are ideal for home computing systems,

small home/office servers, and removable storage/backup applications.

Product Features

• PCI 32bit@33/66 Mhz

• 2 SATA ports at 1.5Gb/s (RR1522A model utilizes external, eSATA ports)

• Up to 2 SATA I (compatible with SATA II) Hard Drives

• Compatible with eSATA enclosures(RR1522A model)

• Supports RAID 0, 1, and JBOD

• BIOS Booting (INT13) to RAID array

• Hot swap and hot spare

• Online array roaming

• Web browser-base software (Web GUI)

• Command Line Interface (CLI)

• SMTP email notification for events and error reporting

• Remote array management through (Web GUI, RAID GUI and CLI)

• Support Windows (XP, 2000, Server 2003 and Vista), Linux and FreeBSD

• RoHS Compliant
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Introduction

Understanding RAID Concepts and Terminology

The following concepts and terminology is commonly used when describing the

functions of the RocketRAID 152x Host Adapter.

Disk Status

Available     The disk can be used for array creation.

Configured   The disk has been assigned to one or more arrays, or configured as a

spare disk.

Array initialization/Duplication

A redundant array (RAID1) needs to be initialized to ensure full performance and

reliability.  Non-redundant arrays (RAID0, JBOD) do not need to be initialized.

A RAID 1 array may also be created using a disk that already contains data.  This data

is duplicated to the second disk during the creation process.
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RocketRAID 152x Hardware Description/Installation

RocketRAID 152x Hardware

RocketRAID 152x Adapter Layout

1 – RocketRAID 1522A Adapter Layout

SATA 1- SATA 2

These represent the RocketRAID 152x’s two eSATA ports.

These ports are designed for use with eSATA (external SATA) enclosures, and are

compatible with SATA and SATAII hard disk drives.

2 – RocketRAID 1520 Adapter Layout
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RocketRAID 152x Hardware Description/Installation

2 - Installing the RocketRAID 152x Host Adapter

Note: Make sure the system is powered-off before installing the RocketRAID 152x

host adapter.

The RocketRAID 152x includes both standard and low-profile brackets.  It may be

necessary to attach the low-profile bracket in place of the standard bracket, depend-

ing upon the chassis design.

1. Open the system chassis and locate an unused PCI slot.

2. Remove the PCI slot cover.

3. Gently insert the RocketRAID 152x into the PCI slot, and secure the bracket to

the system chassis.

SATA 1- SATA 2

These represent the RocketRAID 1520’s two SATA ports.

These ports are compatible with SATA and SATAII hard disk drives.
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4. After installing the adapter, close and secure the system chassis.

5. Install the hard disk drives into the external disk enclosure (sold separately –

consult the enclosure’s manual for the proper hard disk installation procedures).

Attach the enclosure to the RocketRAID 152x’s eSATA ports using the eSATA

data cables.

3 - Verifying Installation

Once the RocketRAID 152x host adapter and hard disks have been installed, boot-up

the system to verify that the hardware is properly recognized.

1. Power on the system.  If the system detects the presence of the adapter, the

RocketRAID 152x BIOS Utility will be displayed during bootup.

2. Press Ctrl+H to access the RocketRAID 152x BIOS Utility.

The BIOS Utility will display information about hard disks attached to the adapter.

Make sure all attached disks are detected by this utility.  If any of the hard disks are

not detected, power down the system and check all cable connections.

RocketRAID 152x Hardware Description/Installation
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RocketRAID 152x BIOS Utility

RocketRAID 152x BIOS Utility

The RocketRAID 152x’s BIOS Utility can be accessed using the “Ctrl+H” command.

This command should be displayed automatically when the RocketRAID 152x’s BIOS

screen appears during the system’s boot up procedure.

1 - BIOS Command Overview

The RocketRAID 152x BIOS Utility provides a wide selection of RAID related

commands.  These commands are displayed towards the top of the utility’s interface.

Command  keys:

Use the ← →arrow keys to scroll through the various commands, and the ↑ ↓
arrows to browse through the corresponding command menus.   Use the ENTER key

to execute the selected command.

The ESC button can be used to cancel the selected command, or return to the previ-

ous command menu.

Create - this command is used to create RAID arrays.   Section 2 discusses this

command in detail.

Delete - this command will delete the selected RAID array.

Warning:  This command may result in permanent data loss - it should only be used

if data stored on the target array is no longer relevant, or has been backed up to an

alternate storage device.

Settings

Set Boot Mark - this function is used to designate a particular disk or RAID array

to function as the RocketRAID 152x’s boot device.

Note:  This setting is only relevant if the motherboard’s BIOS has set the

RocketRAID 152x to function as the system’s primary boot device.

View – this command is used to select between two views. Press the ENTER key to

change the view.
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RocketRAID 152x BIOS Utility

Devices – displays information about hard disks attached to the RocketRAID 152x.

Use the ↑ ↓ arrow keys to highlight the target hard disk, and press ENTER to view

the information.

RAID Arrays – displays information about RAID arrays attached to the RocketRAID

152x.  Use the ↑ ↓ arrow keys to highlight the target array, and press ENTER to view

the information.

Note:  Arrays cannot be created between disks that have not been initialized.

The following section discusses this command in detail.

2 - Creating RAID Arrays

To create an array:

1. Use the ← → arrow keys to highlight the Create command, and press ENTER to

open the Create Menu.

2. Use the ↑ ↓ arrow keys to select the appropriate RAID level (RAID 0, 1 or

JBOD), then press ENTER.

3. Next, use the ↓ arrow key to highlight the Array Name option and press ENTER.

The array name dialogue box will appear.  Use the keyboard to input a new Array

Name, and press the Enter key.

Note: the Array Name command is optional – it is not necessary to name the

array.  The array can be named at a later time, and the name of the array can be

changed at any time.

4. On the Create menu, use the ↓ arrow key to highlight the Select Devices item and

press ENTER. A device list will appear, and display all available hard disk drives.

5. Highlight the target disks that you want to use, and press ENTER to select them.

After all of the disks have been selected, press the ESC key to return to the

Create Menu.

Note:  Multiple arrays can be created using the same set of hard disk drives.

The Capacity option allows you to set aside disk space that be used to create

another array, set as a spare disk, or partitioned to act as a single disk (by the

operating system).
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RocketRAID 152x BIOS Utility

RAID 1 array: Two options are provided when creating RAID 1 (mirror) arrays:

Create Only, and Create and Duplicate.

The Create Only option is used when using new disks, or when starting from

scratch (any data on the disks will be lost).  Do not select this option if you need

to preserve data on either of the disks.

Create and Duplicate allows the administrator to create mirror array using a data

disk.  The first disk selected (Step 4) is designated as the source disk, and the

second is the target.  All data stored on the source disk will be copied to the

target disk.  The BIOS utility will display a progress bar (it will display % comple-

tion of the duplication procedure) if this option is selected.

6. To complete the creation procedure, use the ↓ arrow key to highlight the Start

Creation item and press ENTER.  Press the Y (yes) key to create the array, or N

(no) key to cancel the creation process.

3 - Recovering RAID 1 arrays

The RR152x BIOS utility provides a recovery option for broken RAID 1 arrays.  The

utility will post a warning message during the system’s boot procedure in the case of

a broken array.  If the failed disk is replaced, the BIOS will provide a rebuild option.

All data on the remaining disks will be copied to the replacement disk during this

procedure, and will restore the RAID 1 to it’s normal state.
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RocketRAID 152x BIOS Utility

4 - Updating the BIOS

BIOS updates are released periodically, and posted on our website for download.

In order to update the BIOS, the system must be booted into DOS mode, using a

DOS-boot diskette or CD image.

1) Copy the load.exe and the bios image file to the bootable floppy diskette

(you may need to use a different floppy depending upon how much space is

available on the boot diskette - this can vary).

2) If you are booting from a CD image, you will need to add these files to the

CD.

Insert the boot image media into the appropriate drive, and boot the system.

3)  Once the A:\> prompt has appeared, insert the media that contains the

required BIOS files, and type the following command:

                 load xxx.xxx

              Then, press enter.

Note: xxx.xxx = the name of the BIOS image file (type it exactly as it appears).

4)  The utility will scan for the controller, and ask if you want to backup the

BIOS (save a copy of the current BIOS to a floppy diskette).  This is optional

- you can answer No, and continue.

Note: This option will not function if the system was booted from CD.

5) The utility will then ask if you want to flash the controller (upgrade the

BIOS).  Select Y for yes.

6) The utility will display a progress bar during the flash procedure, then will

attempt verify the update.

7) Once complete, the system can be rebooted.
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Driver and Software CD

The RocketRAID 152x retail box includes a Driver and Software CD.

This CD can be used to generate driver diskettes, and install the RAID Management

software for a variety of operating systems.

To create a driver diskette:

1. Insert the CD into the system’s CD/DVD drive.  The program should start

automatically.

2. Insert a blank floppy diskette into the system’s floppy drive.

3. Click on “Create Driver Diskette”.

4. Click on the “Please Select a Product” drop-down button, and select

‘RocketRAID 152x” from the list.

RocketRAID 152x Driver and Software Installation
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RocketRAID 152x Driver and Software Installation

5. Click on the “Please Select the Diskette you want to create” drop-down button,

and select the appropriate OS from the list.

6. Click on the “OK” button to create the driver diskette.

To install the RAID software:

1. Click on “Install RAID Management Software”.
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RocketRAID 152x Driver and Software Installation

2. Select the desired software from the drop down menu, and click on the “OK”

button.

Windows Driver Installation

Before installing the RocketRAID 152x device driver, make sure the RocketRAID 152x

host adapter and all required hard disks have been installed into the system’s chassis

(refer to the Hardware Installation section, page 2-3).

Installing the RocketRAID 152x driver for an existing Windows XP/

2003/x64/Vista system

After the operating system has booted, Windows will automatically detect the

RocketRAID 152x, and request that a device driver be installed. To install the device

driver, follow the steps outlined below:

1. When the “Found New Hardware Wizard” window appears, select “Install from a

list or specific location (Advanced)”, and click Next to continue.

2. Click on the “Include this location in the search” option, and select the system’s

floppy drive (generally Disk A).  Next, insert the Driver Installation diskette into

the system’s floppy drive.

3. At the Hardware Wizard screen, select the floppy drive as the source, then click

the Next button.  Select the appropriate operating system folder, then click the

Next button.

4. Windows will display a warning message that states the driver has “not been

signed”.  Select “Continue Anyway”, then click Finish when prompted.  When

Windows asks to reboot the system, choose No.

5. Windows will then display a second “Found New Hardware Wizard” window –

repeat steps 1 through 4.

6. Remove the Driver Installation diskette from the floppy drive, then Shut down

and restart the computer.

Installation Verification
After the driver has been installed, and the system has been restarted:

1. Click the Start button, then right-click My Computer icon.  Select the Properties

item from the popup menu.
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RocketRAID 152x Driver and Software Installation

2. In the popup window, select Hardware tab and then click Device Manager

button.

3. Double click the “SCSI and RAID controllers” entry.  If the RocketRAID 152x

device entry is not displayed, or there are “?” or “!” marks displayed near the

RocketRAID 152x entry, the driver has not been installed properly. Delete the

entries and reinstall the driver.

Installing the RocketRAID 152x driver during a fresh Windows

2000/XP/2003/x64/Vista installation

1. After booting from the Windows 2000/XP/2003/Vista CD-ROM, when the Win-

dows Setup blue screen appears, look towards the bottom of the screen.  Win-

dows will prompt you to press the F6 key if you want to install a third party SCSI

or RAID driver.  Press the F6 key at this time.

2. The setup procedure will continue, and will later instruct you to press the “S” key

to specify additional adapters. Press the “S” key as instructed.

3. Next, the setup program will prompt for the insertion of the driver diskette.  Please

insert the driver diskette, and then press ENTER to continue.

4. The next window will display several driver options.  Please select the

RocketRAID 152x Controller for the corresponding operating system, and press

ENTER to continue.

1 - Installing the RAID Management Console/ Interface

Overview
To install the RAID software, locate the setup.exe file located on the floppy diskette

labeled “DISK 1” (or the Disk1 folder, if the software was downloaded).  Double click

this file to start the Installation Wizard.

Note: If the system chassis supports SAF-TE, make sure to select the corresponding

chassis-type/manufacturer when prompted.

There is no need to restart the system after installing the software.  To start the

software, click on the “Start” button, select “Programs”, and click on the “HPT

Management Console.”
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Logging On

The RAID Management Console requires that a user (or Administrator) log on.  The

software is incapable of working with RAID arrays or hard disks attached to the

RocketRAID 152x until the user has logged on.

Default Parameters:

System Address:  127.0.0.1

Port: 7402

User Name: RAID

Password: hpt

Note: The password and user name fields are case sensitive.

The first time the software is used, make sure to enter the information listed above.

After successfully logging on, the software will ask you to alter the password (as a

security precaution).

Enter a password, and press enter.

2 - Software Interface - Overview of commands/func-

tions

After logging on, several new options will become available.

These commands are displayed towards the top of the interface window:

4-5
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Overview of Function-menus (tabs)

File

Remote Control - view information about remote systems

System Configuration - switch between available remote systems

User Management - Add or remove users, edit user profiles

Password - change the password

Exit - exit the utility interface

Management

RAID Management - Create/delete/maintain RAID arrays

Device Management - check information or change settings for host adapters, and

hard disks

Spare management - create and assign spare disks (not available for the RR152x

cards)

System Notification - Set up system notification options

View

Event view - Views the event log

Icon view - view icon descriptions (legend)

Operation

This menu will list all available commands for the selected Function menu.

These commands are also represented in icon/button form (below the function-menu/

tabs selections)

Help

Search through help topics related to the RAID Management Console software

View software version information.
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3 - Creating an Array

To create an array:

1. Highlight the “Management” menu, then select the “Array Management”

function.

2. Click the Create button on the toolbar or select the “Create” command from the

“Operation” menu.  The array creation wizard will appear.

3. Select the desired RAID level from the drop-down list (RAID 0, 1 and JBOD are

supported by the RR152x cards).

4. Enter a name for the array using the keyboard (this is optional), and click the Next

button.

5. If you are creating a RAID 1 array, select an initialization option.  If you are

creating a RAID 0 or JBOD (volume), skip to step 6:

For RAID1 arrays, the default initialization method is “No initialization”.

Write-back - when the write-back setting is selected, all write requests sent to

the array are cached. This will result in higher performance, but data loss may

occur in case of a power failure.

Write-through - when the write-through setting is selected, all write requests

sent to the array are passed directly to the disks. However, subsequent reads

may still be completed from the cache if appropriate.
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6. Select which disks are to be used to create the array.  Highlight the desired disk

from the left-side of the interface (available disks), then click on the  button to

move the disk to the right side of the interface (selected disks).  Disks must be

selected one a time.

If you wish to remove a selected disk, highlight it from the selected disk section,

and use the  button to move it to the available disk section.

Note:  The selection sequence is important - the order in which the disks are

selected will determine the disk sequence of the array.

Note: If you have specified an initialization option, the initialization process will start

automatically.  A progress bar will be displayed towards the bottom of the interface

window, and will indicate % completion, and provide an estimate of the time needed

to complete the initialization procedure.

4 - Deleting an Array

To delete an array:

1. Highlight the “Management” menu, then select the “Array Management”

function.

2. Highlight the array you want to delete, then click on the “Delete Icon” or select

the Delete command from the “Operation” menu.

3. A warning message will appear. Click Yes to delete the array.  Click on cancel to

stop this procedure.

Note: An array in use by the operating system cannot be deleted. Any data stored on

a deleted array will be inaccessible

5 - Recovering/Verifying Arrays

When an array member (hard disk) of a redundant array fails, the array will be marked

as “broken”. You can rebuild the array by adding a new disk to the host adapter. Once

the disk is attached to the card, use the “Rescan” button (see diagram on section 2).

For more information about adding disks, see section 6, Hot-swap(page 4-9)

1. Highlight the “Management” menu, and select the “Array Management”

function.
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2. Highlight the broken array that needs to be rebuilt.

3. Click the Add Disk button on the toolbar or select “Add Disk” command from the

“Operation” menu.

If the disk is successfully added to the array, rebuild process will start

automatically.

Verifying an Array

For a RAID 1 array, the verify process compares the data of one mirror pair with the

other (single hard disk in the case of RAID1).

To verify an array:

1. Highlight the “Management” menu, and select the “Array Management” function.

2. Highlight the array you want to verify.

3. Click the Verify button on the toolbar or select the “Verify” command from the

“Operation” menu.

4. Verify process will start.

6 - Misc. Array/Device Options

Device Management

The Device Management window provides configuration information about control-

lers (the RocketRAID 152x and other HighPoint host adapters), channels and hard

disks.

To access the Device Management window, highlight the “Management” menu, and

select the “Device Management” function.

Hot-Swap

The software provides a hot-swap feature that allows the administrator to add or

remove hard disks from the host adapter w hen used in conjunction with hot-swap

compatible disk enclosures.

JBOD and single disks can be removed when not in use.  Highlight the disk/JBOD

you wish to remove, and click the “Unplug” button.

The hot-swap function is also used when replacing failed RAID 1 disks, in order to

rebuild the array (5 - Recovering/Verifying Arrays, page 4-8).
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To add a disk, install the drive into the appropriate disk enclosure, and use the

“Rescan” button – the host adapter will scan each channel for changes.  The software

will display information about the disk once the host adapter has detected it.

Renaming an Array

1. Highlight the “Management” menu, and select the “Array Management”

function.

2. Highlight the array you want to rename.

3. Click the Rename button on the toolbar or select the “Rename” command from

the “Operation” menu.

4. Enter a new name for the array using the keyboard, and press the OK button to

confirm your selection.

Note: An array running background tasks cannot be renamed.

7 - Managing Events

The HighPoint RAID Management Console will log all events that have occurred on

any host adapter under it’s control.

Viewing Logged Events

To view logged events:

1. Highlight the “View” menu, and select the “Event View” option.

2. In the Event View window, you can filer events, clear events, and save events to a

file.

Configuring E-mail notification

To enable E-mail notification:

1. Highlight the “Management” menu, and select the “Event Notification” function.

2. Click the Setting button on the toolbar or select “Setting” option from the

“Operation” menu.

3. Next, enter the necessary information in the E-mail Notification Setting window.
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Note: The software does not support SMTP servers that require user authentication.

To add a Recipient:

1. Highlight the “Management” menu, and select the “Event Notification” function.

2. Click the “Add” button on the toolbar or select “Add” command from the

“Operation” menu.

3. Enter the necessary information in the Add recipient window.

4. The recipient will be listed in the main window. You can use Modify or Delete

button on the toolbar to modify or delete the recipient.

To test E-mail notification:

1. Highlight the “Management” menu, and select the “Event Notification” function.

2. Select one recipient from the main window.

3. Click the Test button on the toolbar or select the “Test” command from the

 “Operation” menu.

4. The software will send a “test” e-mail message to the selected recipient.
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Managing Tasks

The RAID management Console can be used to setup routine, periodical background-

rebuild or verification tasks that will help maintain the integrity of RAID arrays

attached to the RocketRAID 152x.

To setup and schedule tasks highlight the “Management” menu, and select the “Task

Management” function to open Task Management window.

The Task Schedule list displays all of the tasks assigned to the selected remote

system.  To view detailed information about a specific task, highlight and Double-click

the task’s name.

Add a Scheduled Task

This command is used to add a Scheduled task for the selected remote system.  To

add a new scheduled task:

Click the “New” button on the toolbar.  The new task schedule wizard will appear.
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Select the task type and the array that you want to verify or rebuild, then click

“Next”.
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1. Enter a name for the task.

2. Configure the frequency for the task.

3. Set the duration for the task.

4. Check the “Enable the task” option to activate this task.

5. Click “Finish”.

Modify a Scheduled Task

This command is used to change settings for a scheduled task.  To Modify a Task

Schedule:

1. Select a task from the Task schedule list.

2. Click the “Modify” button on the toolbar, and modify the task settings in the

popup window.

Delete a Scheduled Task

This command is used to delete a Scheduled Task for the selected remote system.  To

delete a Task Schedule:

1. Select a task from the Task schedule list.

2. Click the “Delete” button on the toolbar.

8 - Configuring Remote Systems

Then HighPoint RAID Management Console manages a RAID controller through a

connection to the HighPoint RAID Management Service, which runs on the system

where the RAID host adapter is physically installed.  This type of system is referred

to as a “remote system”.

Note: What the software classifies as a “remote system” may not always be an actual

remote computer.   In some configurations, the local computer hosts both the RAID

host adapter and Management Service.  The local system, in these cases, is still

generically referred to as a “remote system”.

Add a Connection

This command is used to add new connection to a remote system.  To Add a

Connection:
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1. Highlight the “File” menu, and select the “Remote Control” function.

2. Click the Add button on the toolbar or select the “Add” command from the “Opera-

tion” menu.

3. Enter the system address, name, and port information in the popup window.

The system address can be a host name, or an IP address.  The default system port is

7402.

4. Click “OK” to finish adding the new connection.

Modify a Connection

This command modifies connection information for a remote system.  To modify a

connection:

1. Highlight the “File” menu and select the “Remote Control” function.

2. Highlight the system you want to modify.

3. Click the Modify button on the toolbar or select the “Modify” command from the

“Operation” menu.

4. Enter new connection information in the popup window, and click OK to apply

the changes.
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Note: The System Address cannot be modified.  If you insist on modifying this item,

you must first delete this connection and then add a new connection.  In addition, the

connected system cannot be modified – you must first disconnect from this system.

Delete a Connection

This command deletes a remote system from the connection list.  To delete a

connection:

1. Highlight the “File” menu and select the “Remote Control” function.

2. Highlight the system you want to delete.

3. Click the “Delete” button on the toolbar or select the “Delete” command from the

“Operation” menu.

4. A warning message will be displayed.  Click “Yes” to delete the item.  Select No to

cancel this command.

Connect to a Remote System

This command establishes a connection to a remote system for RAID management.

To connect to a remote system:

1. Highlight the “File” menu and select the “Remote Control” function.

2. Highlight the remote system you to establish a connection with.

3. Click the “Connect” button on the toolbar or select the “Connect” command from

the “Operation” menu.

4. Enter the appropriate Login information in the popup window.
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Note: The initial user name/password for a remote system is RAID/hpt.  You are free

to modify the username and password after the connection is established.

If the connection is successful established, the application will retrieve the event logs

from the remote system, then switch to Array Management view.

Disconnect Remote System

This function closes the connection from a connected system.  To disconnect a

remote system:

1. Highlight the “File” menu and select the “Remote Control” function.

2. Highlight the system you want to disconnect from.

3. Select the “Disconnect” command from the “Operation” menu.

System Configuration

This function is used to modify the service configuration on a remote system.  To

change the service configuration:

1. Highlight the “File” menu and select the “Remote Control” function.

2. Highlight the remote system you want to modify.

3. Select the “System Configuration” option from the “Operation” menu.

4. Modify the information in the popup window.

System Port - This is the TCP port number that the RAID Management Service uses

to communicate with RAID Management Console.  When you connect to the service,

the port value you enter must be in accordance with the system port value on the

service.  The default value is 7402.

Event Port - The client software will retrieve events through this port.  The default

value is 7403.

The System Port value must differ from the value assigned to the Event Port.  After
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you reset a system’s configuration, you should restart the service on that system for

the changes to take effect.

5. Click “OK” to apply the changes.

9 - Configuring Users and Privileges

The RAID Management Console allows the Administrator to manage user accounts in

its own database. You can setup multiple users and assign different privileges levels

for the purpose of RAID management.

Users can be assigned to each individual Remote System controlled by the RAID

Management Console.

Highlight the “File” menu and select the “User Management” function to configure

User related options for the selected remote system.

The user management window lists all users assigned to the selected remote system.

The current/active user will be designated with an icon.

Add a User

This function adds a user account to the connected remote system.  To add a user:

1. Click the “Add” button in the User Management window.

2. In the popup window, enter the user name, enter and confirm the password, and

then click “Next”.
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3. Select the appropriate privileges for the user.

4. Click “Finish”.

Delete a User

This function deletes a user’s account on the connected remote system.  To delete a

user:

1. Select the target user ID from the User list displayed in the User Management

window.

2. Click Delete to remove the selected user. Click “Yes” to delete the item.  Select “No”

to cancel this command.

Note: An active user (user currently utilizing the software) cannot be deleted from the

console.

Set Password

The Administrator uses this function to set a user’s password – the password allows

a user to log on to a remote system, and utilize the RAID Management Console.  To

set password for a user:

1. Select the target user ID from the user list displayed in the User Management

window.

2. Click the “Set Password” option, and enter the password for the user.

3. Click OK to apply your selections.
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The Administrator uses this function set a user’s privileges for the selected remote

system.  To set privileges for a user:

1. Select the target user ID from the user list displayed in the User Management

window.

2. Click the “Set Privilege” option.

3. In the popup window, assign the privileges for the selected user.

4. Click OK to apply your selections.

RocketRAID 152x Driver and Software Installation
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1 - Fedora Core 6 Linux installation Overview

This section provides instructions describing how to install and utilize the

RocketRAID 152x Adapter on a Fedora Core 5 Linux system.

2 - Installing Fedora Core 6 on the RocketRAID 152x

Host Adapter

Note: If the OS is running kernel that differs from the one supported by the

precompiled driver, the precompiled drivers cannot be used.  A driver can be built for

this kernel using the OpenSource package for the RocketRAID 152x controller.   This

package is available from our website, and is posted on the BIOS/Driver page for the

RocketRAID 152x.

To install Fedora Linux onto hard disks or RAID arrays attached to RocketRAID 152x

controller, follow the steps outlined below:

Step 1 Prepare the Driver Diskette

The driver is contained in a floppy diskette image file.

On a DOS or Windows system, a Fedora driver diskette can be generated using

rawrite.exe.  This utility is included on the Fedora Linux CD (under /dosutils).  Run

rawrite using a command prompt window, and follow the directions it provides.

On a Linux system, use the “dd” command to generate a boot diskette.  Insert a

floppy disk into the floppy drive and type the following command:

          # dd if=fc1dd.img of=/dev/fd0

Note: The driver disk image file depends on your core version and hardware.

Step 2 Install Fedora Linux

Installation steps for Fedora Core 6

1) Boot from the Fedora Installation CD, and start the install procedure.

2) At the “Welcome to Fedora Linux” installation screen, a prompt labeled “boot:” will

appear at the bottom of the screen.  Type in “linux dd updates hde=noprobe

hdf=noprobe hdg=noprobe hdh=noprobe” (without quotation marks) and then press

Enter.
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driver disk and press OK to continue” prompt, insert the driver diskette in the floppy

drive and then select “OK”.

4) The system will now load the RocketRAID 152x driver automatically.

5) When Fedora asks you to partition the disk, check the “Review and modify the

partitioning layout” box towards the bottom of the screen. Click “Next” to Continue.

Configure the partition as desired, and click Next once more.

6) Check the “Configure advanced boot loader options”, and click “Next” to continue.

7) In the “General kernel parameters” field, type in”hde=noprobe hdf=noprobe

hdg=noprobe hdh=noprobe” and press “Next” to continue.  You are now free to follow

the standard installation procedures.

3) When prompted “Do you have a driver disk?”, select “Yes”.  At the “Insert your
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3 - Installing the RocketRAID 152x driver for an Exist-

ing System

Note: If a SCSI adapter is used to boot the system, make sure the RocketRAID 152x

controller BIOS loads/posts after the SCSI adapter’s BIOS.  It may be necessary to

move the adapter(s) to another PCI slot.

Step 1 Obtain the Driver Module

Extract the module file from the file modules.cgz (from the driver disk) using the

following commands:

      # mount /dev/fd0

      # cd /tmp

      # gzip -dc /media/floppy/modules.cgz | cpio -idumv

Driver modules for all supported kernel versions will be extracted. The driver module

for the active kernel is located under the directory that matches the kernel version (/

tmp/‘uname –r‘/athlon/hpt37x2.o).

After extracting the driver module, load it using the following commands:

        # insmod scsi_mod

# modprobe sd_mod

# insmod hpt37x2.ko

Arrays attached to the adapter can be accessed as SCSI devices (e.g. /dev/sda).
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Next, use the “mkfs /dev/sda1” command to setup a file system on this partition.

 Use the command “mkdir xxxx” to create a mount point for the RAID array.

Then mount /dev/sda1 /xxxx in order to access it.

Note: xxxx represents the desired name of the mount point.

Step 3 Configure System to Automatically Load the Driver

To avoid typing in “insmod rr152x.ko” each time the operating system is booted, the

system must be instructed to automatically load the module during bootup. To install

the module, type in the following commands (first change to the directory where the

proper rr152x.ko file is located):

#cp hpt37x2.ko /lib/modules/‘uname –r‘/kernel/drivers/scsi

#depmod

Then, instruct the system to load the module when booting.  Use the following

commands:

#echo “hpt37x2” > /etc/init.d/hptdriver

#chmod 755 /etc/init.d/hptdriver

#ln –sf /etc/init.d/hptdriver /etc/rc.d/rc3.d/S01hptdriver

#ln –sf /etc/init.d/hptdriver /etc/rc.d/rc4.d/S01hptdriver

       #ln –sf /etc/init.d/hptdriver /etc/rc.d/rc5.d/S01hptdriver

Step 4 Configure System to Mount Volumes during Startup

The system can be instructed to automatically mount the array(s) during startup by

modifying the file”/etc/fstab”.

For example, add the following line to tell the system to mount /dev/sda1 to location /

mnt/raid after startup:

/dev/sda1       /mnt/raid           ext3    defaults   0 0

This array will be registered to the system as device “/dev/sda”.

To create a partition on this array (which will listed as /dev/sda1), use the “fdisk /

dev/sda” command.

Example: A RAID array has been configured between several hard disks.

Step 2 Mounting and Partitioning the Device
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2. If the original driver is installed in the /lib/modules/‘uname –r‘/kernel/drivers/

scsi/ directory, and loaded by the script file (Example /etc/init.d/hptdriver) during

the init process, or the configure file (Example /etc/modules.conf), please replace

it with the new driver hpt37x2.o o or hpt37x2.o ko).

5 - Uninstalling the Driver

To uninstall the RocketRAID 152x driver

Note: The driver cannot be uninstalled while the system is booted from a disk or array

attached to the RocketRAID 152x.

To uninstall the driver, remove the lines added to /etc/fstab, and remove the files

created in the /etc/init.d directory.

      (when using a system installed to the RocketRAID 152x controller, for example),

the driver module in the initrd file should be updated using the mkinitrd com-

mand (or extract the initrd file and replace the driver module manually).

4 - Updating the Driver

1. If the original driver is installed in the system’s initrd (Initial RAM Disk) file
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On a DOS or Windows system, a driver diskette can be generated using rawrite.exe.

This utility is included on the SuSE Linux CD (under /dosutils).  Run rawrite using a

command prompt window, and follow the directions it provides.

1 – SuSE Linux 10.1 installation Overview

This section provides instructions describing how to install and utilize the

RocketRAID 152x Adapter on a SuSE Linux system.

2 - Installing SuSE Linux on the RocketRAID 152x Host

Adapter

Note: If the OS is running kernel that differs from the one supported by the

precompiled driver, the precompiled drivers cannot be used.  A driver can be built for

this kernel using the OpenSource package for the RocketRAID 152x controller.   This

package is available from our website, and is posted on the BIOS/Driver page for the

RocketRAID 152x.

To install SuSE onto hard disks or RAID arrays attached to RocketRAID 152x

controller, follow the steps outlined below:

Step 1 Prepare the Driver Diskette

The driver is contained in a floppy diskette image file (slesdd.img).

On a Linux system, use the “dd” command to generate a boot diskette.  Insert a

floppy disk into the floppy drive and type the following command:

# dd if=susedd10.1.img of=/dev/fd0

Step 2 Install SLES Linux

1. Start the install procedure by booting from SLES installation CD.

2. After the CD boots, select the “Installation” option and press F5 to load the

driver.

3. Insert the Driver Diskette when it displays “Please insert the Driver Update

floppy”.

4. For SuSE 10.x, type “brokenmodules=hpt366” and press enter.

5. When the “Diver Update Menu” is displayed, press “OK” and “back” for back

to installer.

SuSE Linux 10.1 (Open and Novell) Driver Support
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3 - Installing the RocketRAID 152x Driver on an Exist-

ing System

If you are currently running SLES and would like to access drives or arrays attached

to the Rocket RAID152x controller, follow the steps outlined below:

Note:

1. If a SCSI adapter is used to boot the system, make sure the RocketRAID 152x

controller BIOS loads/posts after the SCSI adapter’s BIOS.  It may be

necessary to move the adapter(s) to another PCI slot.

2. The driver may work incorrectly on certain motherboards (such as DFI77B

KT400). For these motherboards, add the “acpi=off” kernel parameter in the /

boot/grub/menu.lst:

kernel (hd0,1)/vmlinuz root=/dev/hda1 acpi=off

initrd (hd0,1)/initrd
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6. Installation will now proceed normally. Refer to the SuSE Linux documentation

for additional OS installation procedures.

Additional Installation Notes:

The system device mapping order is the same as the order shown in RocketRAID

RR152x BIOS Setting Utility.  If no other SCSI adapters are installed, the device

marked as “BOOT” or “HDD0” will be identified as /dev/sda, “HDD1” as /dev/sdb,

“HDD2” as /dev/sdc, etc.  When creating mount points, /boot must be mounted on /

dev/sda.

For SuSE 10.x, please format the /boot partition using ext3 format (default is reiserfs).

Otherwise, the GRUB boot loader will overwrite the RAID information stored on

sector 9 and cause your RAID array to be broken.

On some systems, after you install one or more RR1520 controllers, the Linux kernel

may be unable to probe the onboard IDE controller - this may disable access to the

CD-ROM. If this occurs, try adding the line “ide0=0x1f0,0x3f6,14 ide1=0x170,0x376,15”

in the boot parameters.
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# modprobe scsi_mod

# modprobe sd_mod

# insmod hpt37x2.ko

Then you can access the arrays attached to the controller as SCSI devices (e.g. /dev/

sda).

To ensure the module has been loaded successfully, you can check the driver status

by typing in the command “cat /proc/scsi/hpt37x2/x”, where x is the filename you

found under /proc/scsi/hpt37x2/. You should see the driver banner and a list of

attached drives. You can now access the drives as a SCSI device (the first device is /

dev/sda, then /dev/sdb, etc.).

Step 3 Mounting and Partitioning the Device

Note: Many versions of SuSE include YAST.  YAST is a graphical configuration

utility that is capable of executing the commands described below.  We recommend

using YAST, if available, as it may help simplify the installation process.

Step 1 Update Grub

For SuSE Linux 10.x, please remove hpt366.ko from both the initrd image and /lib/

modules/…/kernel/drivers/ide/pci directory:

Check /etc/sysconfig/kernel for INITRD_MODULES=… line. If the hpt366 module is

configured you should remove it, and run “mkinitrd” to recreate the initrd image. -

Remove /lib/modules/`uname –r`/kernel/drivers/ide/pci/hpt366.ko.  Then reboot the

system to allow the new kernel parameter take effect.

Step 2 Install the Driver Module

Extract the module file from the file /linux/suse /[arch]-[version]/install/update.tar.gz

(from the driver disk), using the following commands:

# mount /dev/fd0 /mnt/floppy

# cd /

# tar xfz /mnt/floppy/linux/suse/i386—10.1/install/update.tar.gz

The driver modules will be extracted to the directory /lib/modules/[kernel-ver]/kernel/

drivers/scsi/ .

After you have extracted the driver module, you can load it using the following

commands:
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 This array will be registered to the system as device “/dev/sda”.

1. To create a partition on this array (which will listed as /dev/sda1), use the

“fdisk /dev/sda” command.

2. Next, use the “mkfs /dev/sda1” command to setup a file system on this

partition.

3. Use the command “mkdir xxxx” to create a mount point for the RAID array.

Then, mount /dev/sda1 /xxxx in order to access it.

Note: xxxx represents the desired name of the mount point.

Step 4 Configure System to Automatically Load the Driver

To avoid typing in “insmod hpy37x2.ko” each time the operating system is booted,

the system must be instructed to automatically load the module during bootup. You

can add the driver to the initial RAM disk image to load the driver at boot time:

1. Backup the initial RAM disk at first.    # mv /boot/initrd-‘uname –r‘ /boot/

initrd-‘uname –r‘.backup

2. Edit file /etc/sysconfig/kernel and append hpt37x2 module to the line

INITRD_MODULES=…, e.g: INITRD_MODULES=”… piix hpt37x2”

Example: A RAID array has been configured between several hard disks.

3. Run mkinitrd to update the initrd file: # depmod -a  # mkinitrd

4. If you are using lilo boot loader, run lilo again: # lilo Then reboot your

system and the driver will be loaded.

Step 5 Configure System to Mount Volumes during Startup

The system can be instructed to automatically mount the array(s) during startup by

modifying the file”/etc/fstab”.

For example, add the following line to tell the system to mount /dev/sda1 to location /

mnt/raid after startup:

/dev/sda1       /mnt/raid           ext2    defaults   0 0
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4 – Updating the Driver

To update the driver, simply reinstall the driver following the steps in previous

section, “ Install RocketRAID 152x Driver on an Existing System “.

Note: If the driver is loaded in initrd (when system is installed onto a disk or array

attached to the RocketRAID 152x), you need to run the mkinitrd command to update

the initrd file. If you are using the lilo boot loader, run lilo again (# lilo).

5 – Installing the RAID Management Software

HighPoint RAID Management Software is used to configure and keep track of your

hard disks and RAID arrays attached to RR152x controller. Installation of the manage-

ment software is optional but recommended. To configure HighPoint RAID Manage-

ment Software to work with RR152x driver, you should setup /etc/hptcfg to be the

driver name:  # echo hpt37x2 > /etc/hptcfg Please refer to HighPoint RAID Manage-

ment Software documents for more information (updated versions are always avail-

able from the HighPoint website).

6 - Uninstalling the Driver

To uninstall the RocketRAID 152x driver

Note: The driver cannot be uninstalled while the system is booted from a disk or array

attached to the RocketRAID 152x.

To uninstall the driver, remove the lines added to /etc/modules.conf and /etc/fstab.
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1 - Installing FreeBSD on the RocketRAID 152x Con-

troller

If you would like to install FreeBSD onto arrays attached to the RocketRAID 152x

host adapter, please follow the steps below.

Step 1 Prepare the Driver Diskette

When installing FreeBSD to a disk or array attached to the RocketRAID 152x, you

must prepare a RocketRAID 152x driver diskette before starting the installation

procedure.  The driver is compatible with both the RocketRAID 1520 and RocketRAID

1522A, and is labeled as “152x” to reflect this.

First, obtain the driver diskette image file from the driver package.

In a DOS or Windows system, create the boot diskette using the rawrite.exe utility.

This utility can be found on the FreeBSD CD (under \tools). Run it under a DOS-

Prompt window and follow it’s prompt.

On a FreeBSD system, use the “dd” command to make the driver diskette. For

example, Insert a floppy disk into the floppy drive and type the following command (if

you are installing FreeBSD 5.x versions):

          # dd if=freebsd_5.x.img of=/dev/fd0

Step 2 Install FreeBSD

1. Start the FreeBSD installation procedure by booting from installation CD.

2. If you are installing FreeBSD 5.0 or earlier versions, skip this step. When the

“Welcome to FreeBSD” screen appears, select “6”.

3. When the “Hit [enter] to boot immediately or any other key for command

prompt” screen appears, press the SPACE key to stop the loader from

autobooting.

BTX loader 1.00  BTX version is 1.01

Console: internal video/keyboard

FreeBSD Driver Support
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BIOS driver A: is disk0

BIOS driver B: is disk1

BIOS driver C: is disk2

BIOS 636kB/74512kB available memory

FreeBSD/i386 bootstrap loader, Revision 0.8

(mailto:jkh@narf.osd.bsdi.com, Sat Apr 21 08:46:19 GMT

2001)

-

Hit [Enter] to boot immediately, or any other key for

command prompt.

Booting [kernel] in 9 seconds…

 <-press SPACE key

A prompted label “ok” will appear at the bottom of the screen.

4. Insert the RocketRAID 152x driver diskette into floppy drive. Type in “load diskx:

hpt37x2-x.x”  (without quotation marks), and then press enter.

for FreeBSD 4.3-RELEASE

ok load kernel

ok load disk1:hpt37x2-4.3.ko

for FreeBSD 4.4-RELEASE

ok load kernel

ok load disk1:rr152x-4.4.ko

for FreeBSD 4.5-RELEASE

ok load disk1: hpt37x2-4.5.ko

for FreeBSD 4.6.2-RELEASE

ok load disk1: hpt37x2-4.6.2.ko

for FreeBSD 4.7-RELEASE

ok load disk1: hpt37x2-4.7.ko

for FreeBSD 4.8-RELEASE

ok load disk1: hpt37x2-4.8.ko
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for FreeBSD 4.9-RELEASE

ok load disk1: hpt37x2-4.9.ko

for FreeBSD 4.10-RELEASE

ok load disk1: hpt37x2-4.10.ko

for FreeBSD 4.11-RELEASE

ok load disk1: hpt37x2-4.11.ko

for FreeBSD 5.0-RELEASE

ok load disk0: hpt37x2-5.0.ko

    for FreeBSD 5.1-RELEASE

ok load disk0: hpt37x2-5.1.ko

     for FreeBSD 5.2.1-RELEASE

ok load disk0: hpt37x2-5.2.1.ko

     for FreeBSD 5.3-RELEASE

ok load disk0: hpt37x2-5.3.ko

    for FreeBSD 5.4-RELEASE

      ok load disk0: hpt37x2-5.4.ko

    for FreeBSD 5.3-AMD64-RELEASE

      ok load disk0: hpt37x2-5.3-amd64.ko

    for FreeBSD 5.4-AMD64-RELEASE

      ok load disk0: hpt37x2-5.4-amd64.ko

    for FreeBSD 6.0-AMD64-RELEASE

      ok load disk0:hpt37x2-6.0-amd64.ko

    for FreeBSD 6.1-RELEASE

      ok load disk0:hpt37x2-6.1.ko

 for FreeBSD 6.1-AMD64-RELEASE

      ok load disk0:hpt37x2-6.1-amd64.ko
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5. After the driver has been loaded, remove the floppy diskette from the floppy

drive.

6. Type in “boot” and continue with installation as normal. Refer to FreeBSD

installation guide for additional information.

ok boot

Note: On some systems, when ACPI is enabled, FreeBSD may not function

properly. Try disabling ACPI in the motherboard’s BIOS settings, or type the

command “set hint.acpi.0.disabled=”1”” under the boot prompt, in order to

solve the problem.

7. Before exiting installation, an additional step must be taken to copy the

RocketRAID 152x driver module to the system. On the driver diskette, there is a

setup script labeled “postinstall”, which will complete this task. Before rebooting

the system, press Alt-F4 to enter the command shell, and type the following

commands:

# mount –o ro /dev/fd0 /mnt

# sh /mnt/postinstall

# umount /mnt

      Then, press Alt-F1 to return to the setup screen, and choose [X Exit Install] to

finish setup.

2 - Installing the RocketRAID 152x Driver on an Exist-

ing System
If you are currently running FreeBSD and would like to access drives or arrays

attached to the RocketRAID 152x Controller, follow the steps outlined below:

Step 1 Copy the Driver Module

If you have made FreeBSD drivers into a diskette, you can insert the driver diskette to

floppy drive, then using the following commands to copy the driver module:

For FreeBSD 4.x:

# mount –o ro /dev/fd0 /mnt

# cp /mnt/hpt37x2-xxx.ko /modules/hpt37x2.ko

# umount /mnt
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For FreeBSD 5.x:

# mount –o ro /dev/fd0 /mnt

# cp /mnt/hpt37x2-xxx.ko /boot/kernel/hpt37x2.ko

# umount /mnt

Alternately, it is possible extract the files from the .img files directly, without using a

floppy diskette:

For FreeBSD 4.x:

# vnconfig vn0c freebsd_xxx.img

# mount /dev/vn0c /mnt

# cp /mnt/hpt37x2-xxx.ko /modules/ hpt37x2.ko

# vnconfig –du vn0c myfilesystem mount=/mnt

 For FreeBSD 5.x:
# mdconfig –a –t vnode –f freebsd_5.x.img –u 0

# mount /dev/md0 /mnt

   # cp /mnt/ hpt37x2-xxx.ko /boot/kernel/ hpt37x2.ko

# umount /mnt

# mdconfig –d –u md0

Step 2 Test the Driver Module

Test the driver module to ensure that it works with the system, by loading it during

bootup. If the module has been loaded successfully you should see the RocketRAID

152x banner and a display screen of the attached drives. You can now access the

drives as a SCSI device.

Note: If you have no other SCSI device, the first device is /dev/da0, then /dev/da1,

etc.).

Example:       F1 FreeBSD

Default: F1

>> FreeBSD/i386 BOOT

Default: 0:ad(0,a)/boot/loader

boot:

BTX loader 1.00  BTX version is 1.01

Console: internal video/keyboard
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BIOS driver A: is disk0

BIOS driver C: is disk2

BIOS 636kB/74512kB available memory

FreeBSD/i386 bootstrap loader, Revision 0.8

(mailto:jkh@narf.osd.bsdi.com, Sat Apr 21 08:46:19 GMT

2001)

Loading /boot/defaults/loader.conf

/kernel text=0x24f1db data=0x3007ec+0x2062c -

<- For FreeBSD 5.1 and later: select “6” on “Welcome to

FreeBSD” screen.

Hit [Enter] to boot immediately, or any other key for

command prompt.

Booting [kernel] in 9 seconds…

 <-press SPACE key

Type ’?’ for a list of commands, ’help’ for more de-

tailed help.

ok load hpt37x2

/modules/ hpt37x2.ko text=0xf571 data=0x2c8+0x254

ok autoboot

Note: If you have configured a RAID 0 using 2 disks, it will be registered to system

as device /dev/da0. You can use “/stand/sysinstall” to create partitions and

disklabels (like da0s1e) on da0. Then, create a new filesystem using “newfs /dev/

da0s1e”. Now you can mount /dev/da0s1e to somewhere to access it

Step 3 Configure System to Automatically Load the Driver

To avoid typing in “load hpt37x2” each time the operating system is booted, the

system must be instructed to automatically load the module during bootup.  To

configure the system to automatically install the module, type in the following

commands:

# echo ’hpt37x2_load=”YES”’ >> /boot/defaults/

loader.conf

This command will instruct the loader to load the RocketRAID 152x module together

with the kernel.   After using this command, reboot the system.  The RocketRAID152x
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module should now automatically load each time the operating system starts up.

Note: When using FreeBSD 4.x, type in the following command to configure the

system:

# mknod  /dev/hpt37x2  c  200  0

Then, check to make sure the node “/dev/hpt37x2¡±, is present in the /dev directory.

Step 4 Configure the System to Mount Volumes at Startup
Instruct the system to automatically mount the array by modifying the file /etc/fstab.

Example: Add the following line to instruct the system to mount /dev/da1s1e to

location /mnt/hpt after startup:

/dev/da1s1e       /mnt/hpt           ufs    rw   0    0

3 - Updating the Driver
To update the driver with a newer revision, simply reinstall the driver following the

steps discussed in the previous section, “Install the driver on an existing system”.

4 Installing the RAID Management Software

The HighPoint RAID Management Software is used to configure and keep track of

your hard disks and RAID arrays attached to RR152x controller. Installation of the

management software is optional but recommended. To configure the HighPoint

RAID Management Software to work with RR152x driver, you should setup /etc/

hptcfg to be the driver name:  # echo hpt37x2 > /etc/hptcfg Please refer to HighPoint

RAID Management Software documents for more information.

5 – Uninstalling the Driver

The driver can only be uninstalled when the system is not booting from devices

attached to the RocketRAID 152x controller. To uninstall, remove the line

rr152x_load=”YES” located in /boot/defaults/loader.conf, and then delete the driver

module /modules/rr152x.ko or /boot/kernel/rr152x.ko.
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Customer Support

If you encounter any problems while utilizing the RocketRAID 152x, or have any

questions about this or any other HighPoint product, feel free to contact our Cus-

tomer Support Department.

Troubleshooting Checklist

Before contacting our Customer Support department:

Make sure the latest BIOS, driver and RAID Software have been installed for the

RocketRAID 152x.  Updates are available from our website.

Prepare a list of the computer system’s hardware and software (motherboard, CPU,

memory, other PCI devices/host adapters, operating system, applications)

 Contact Information

E-mail address: support@highpoint-tech.com

Phone: 408-942-5800 (request for support)

9:00AM-6:00PM, Pacific Standard Time

Additional information about HighPoint products is available from our web site:

http://www.highpoint-tech.com

Customer Support
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FCC Part 15 Class B Radio Frequency Interference statement

This equipment has been tested and found to comply with the limits for a Class B

digital device, pursuant to part 15 of the FCC Rules.  These limits are designed to

provide reasonable protection against harmful interference in a residential installation.

This equipment generates, uses and can radiate radio frequency energy and, if not

installed and used in accordance with the instructions, may cause harmful interfer-

ence to radio communications.  However, there is no guarantee that interference will

not occur in a particular installation.  If this equipment does cause harmful interfer-

ence to radio or television reception, which can be determined by turning the equip-

ment off and on, the user is encouraged to try to correct the interference by one or

more of the following measures:

� Reorient or relocate the receiving antenna.

� Increase the separation between the equipment and receiver.

� Connect the equipment into an outlet on a circuit different from that to which the

receiver is connected.

� Consult the dealer or an experienced radio/TV technician for help.

Modifications not expressly approved by the manufacturer could void the user’s

authority to operate the equipment under FCC rules.

This device complies with part 15 of the FCC Rules.  Operation is subject to the

following two conditions: (1) this device may not cause harmful interference, and (2)

this device must accept any interference received, including interference that may

cause undesired operation.

European Union Compliance Statement

This Information Technologies Equipment has been tested and found to comply

with the following European directives:

� European Standard EN55022 (1998) Class B

� European Standard EN55024 (1998)


